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Overview
This chapter introduces SnagIt/32, outlines its system requirements and describes its on-line 
documentation and Help facility. It also provides you with information on how to contact us with your 
comments and questions.
What does SnagIt/32 do? 
SnagIt/32 system requirements 
Using on-line Documentation 
README.TXT 
SnagIt/32 support 



What does SnagIt/32 do?
SnagIt/32 provides Microsoft Windows users with an easy way to capture, print, file or mail Windows 
screen images.
With SnagIt/32, you can capture an entire screen, a portion of the screen or a specific window. SnagIt/32 
also accepts input from the Windows clipboard, or a Windows bitmap (BMP) file.
You can send the captured image to the Windows Clipboard, to a file, to a printer or to a mailnote.
Sending the image to the Clipboard allows you to immediately paste the image into other Windows 
applications, such as word processors and desktop publishing programs. Placing the image in a saved file
allows you to later import it into your applications. Sending the image to the printer allows you to make 
immediate use of the hardcopy output. Having the image immediately attached to a mailnote enables the 
timely and accurate sharing of your current screen information with others using network mail.



SnagIt/32 system requirements
SnagIt/32 requires the following:

· An IBM PC or compatible that meets Microsoft Windows 95 or Windows NT minimum hardware 
requirements.

· Microsoft Windows 95 or Windows NT version 3.50 or later.
· A mouse or other pointing device.
· For mail output, a 32-bit MAPI mail client (e.g., Microsoft Exchange) must be configured.
· For printed output, a Windows-supported printer capable of printing bitmaps.

(This includes most laser, dot matrix and ink jet printers. Note that many plotters cannot print 
bitmaps, and consequently, may not be able to print images captured with SnagIt/32.)



Using on-line Documentation
SnagIt/32 has a Help system that gives you on-line access to the manual.
Selecting Quick Help from the Help menu provides an instant overview of SnagIt/32 essentials.
For information about how to use on-line Help, choose How to Use Help from the Help menu.
Selecting System Info from the Help menu displays a dialog box that contains information about your 
screen mode and printer type.
Selecting About from the Help menu displays a dialog box listing the version number for this copy of 
SnagIt/32.



README.TXT
Refer to the README.TXT file on the SnagIt/32 diskette for recent information not included in this online 
manual.



SnagIt/32 support
TechSmith is committed to providing a reliable, high-quality product that is easy to use. If you have a 
problem installing or using SnagIt/32, please contact us in one of the following ways:

By mail: TechSmith Corporation
Attn.: SnagIt/32 Support
P.O. Box 4758
East Lansing, MI    48826-4758

By phone: (517) 333-2100
By fax: (517) 333-1888
Internet: SnagIt@techsmith.com
CompuServe: 75226,3136

If you are reporting a problem with SnagIt/32, please have the following information available:
· The product name and version number (SnagIt/32 3.0), and your serial number (displayed on the 

SnagIt/32 diskette label).
· Your name, address and telephone number.
· Your hardware configuration.
· A description of the problem, and what you were trying to do when the problem occurred.



Getting Started

This chapter describes how to install and use SnagIt/32.
Installing SnagIt/32 
Using SnagIt/32 



Installing SnagIt/32
The SnagIt/32 installation program, SETUP.EXE, is a Microsoft Windows application. You must have 
Windows 95 or Windows NT installed before you can install SnagIt/32.
To install SnagIt/32:

1. Start Windows, if you have not already done so.
2. Insert the SnagIt/32 diskette into a floppy drive.

For Windows 95 users:
3. From the Start menu,    select Run.
4. In the Run dialog box, enter:

a:\setup
(If you are installing SnagIt/32 from a diskette drive other than the a:\ drive, you will need to 
change the drive letter in the command line above.)

For Windows NT users:
3. From the Program Manager menu bar, choose File, and select Run from the drop-down menu.
4. In the File Run dialog box, enter:

a:\setup
(If you are installing SnagIt/32 from a diskette drive other than the a:\ drive, you will need to 
change the drive letter in the command line above.)

For all users:
5. Click on the OK button.
6. In the Setup Options box, do the following:

· Enter the name of the directory where you want to install SnagIt/32, or accept the default 
Windows directory.

· Enter the Windows group to which the SnagIt/32 icon should be added, or accept the default 
Accessories group.

7. In the Startup Options box, do the following:
· If you want SnagIt/32 to load automatically when you start Windows, check the Start 

SnagIt/32 when Windows starts box. This will add SnagIt/32 to the Windows Startup group.
· If you want SnagIt/32 to start as a minimized icon, check the Minimize SnagIt/32 when 

started box.
8. When you have finished entering the setup information, click on the Install button to install 

SnagIt/32.



Using SnagIt/32
Starting SnagIt/32 
SnagIt/32 default settings 
Invoking SnagIt/32 with the hotkey(s) 
Using the mouse to select images 



Starting SnagIt/32
For Windows 95 users:

· To start SnagIt/32, click on the SnagIt/32 icon found in the Start menu, under Programs / 
Accessories. (If you specified a group other than Accessories during SnagIt/32 installation, look in
that group for the SnagIt/32 icon.)

· Clicking on the SnagIt/32 icon will execute SnagIt/32 and bring it to the foreground in its 
maximized form. When SnagIt/32 is maximized, you can change any of the setup options (Input, 
Output, Format, etc.) from the SnagIt/32 menus.

For Windows NT users:
· To start SnagIt/32, double-click on the SnagIt/32 icon in the Accessories group. (If you specified a

group other than Accessories during SnagIt/32 installation, look in that group for the SnagIt/32 
icon.)

· Double-clicking on the SnagIt/32 icon will execute SnagIt/32 and bring it to the foreground in its 
maximized form. When SnagIt/32 is maximized, you can change any of the setup options (Input, 
Output, Format, etc.) from the SnagIt/32 menus.

If you selected the "Start SnagIt/32 when Windows starts" checkbox during installation, or if you have 
manually placed the    SnagIt/32 in your Windows Startup group, SnagIt/32 will start automatically each 
time you start Windows.



SnagIt/32 default settings
When you install SnagIt/32, it uses the following default options:

· Input is set to "Screen". SnagIt/32 is configured to capture the entire Windows desktop.
· Output is set to "Printer". SnagIt/32 is configured to send the captured image to the Windows 

default printer.
· Format is set to "Color". SnagIt/32 will capture the image with the screen colors intact. (In most 

cases you can print images captured using this setting, even if your printer is not a color printer.)
· Scale is set to "Proportional". This means that SnagIt/32 will proportionally scale the image to fill 

your current Windows default printer page.

A summary of your current settings will always be displayed as a status line in the lower section of the 
SnagIt/32 Control window.



Invoking SnagIt/32 with the hotkey(s)
Once you have set SnagIt/32's parameters, you are ready to capture screen images.
The default hotkey sequence for invoking SnagIt/32 is CTRL+SHIFT+P. When you press these keys, 
SnagIt/32 will capture an image from the screen (determined by the input parameter you selected), and 
send that image to the output designated.



Using the mouse to select images
You will need to use a mouse or other pointing device with SnagIt/32. The left and right mouse buttons 
work as follows:
Left Button Use the left mouse button to select SnagIt/32 menu options, and to select screen 

regions and windows to capture.
Right Button Use the right mouse button to cancel a region or window selection, by pressing it 

before you release the left mouse button. 



SnagIt/32 Configuration Options

This chapter describes how to configure SnagIt/32, including input, output, format and other options, as 
well as keyboard commands and command-line arguments.
Auto-Load option 
Keyboard commands 
Input options 
Output options 
Format options 
Other options 
Command line arguments 



Auto-Load option
By default, the SnagIt/32 Setup program configures Windows to load SnagIt/32 automatically whenever 
you start Windows. 
The easiest way to change this configuration after installation is to re-run SnagIt/32 Setup from the 
SnagIt/32 distribution diskette. 

· If you have configured SnagIt/32 to auto-load but no longer want it to do this, clear the Start 
SnagIt/32 when Windows starts box on the SnagIt/32 Setup screen. This will remove SnagIt/32 
from the Windows Startup group, and SnagIt/32 will no longer load on Windows startup.

· If you do not have SnagIt/32 configured to load automatically but you want to start loading it 
whenever you start Windows, check the "Start SnagIt/32 when Windows starts" box on the 
SnagIt/32 Setup screen. This will add SnagIt/32 to the Windows Startup group.



Keyboard commands
Invoking SnagIt/32 from the keyboard 
Hiding the SnagIt/32 window 



Invoking SnagIt/32 from the keyboard
The default hotkey sequence for invoking SnagIt/32 is CTRL+SHIFT+P. When you press this key 
combination, SnagIt/32 will capture the part of the screen you specified as the input option, and send that 
image to the device you specified as the output option.



Hiding the SnagIt/32 window
The default hotkey sequence for displaying or hiding the SnagIt/32 window or icon is CTRL+SHIFT+X. 
When you press this key combination, the SnagIt/32 window or icon will disappear from the Windows 
desktop, leaving SnagIt/32 running. Pressing it again will restore the SnagIt/32 window or icon to the 
Windows desktop.



Input options
The SnagIt/32 Input options allow you to define the screen area to be captured. Your options include 
Screen, Entire Window, Window Client Area, Last Active Window, Region, BMP File and Clipboard. You 
also have the option of including the cursor in the captured image by selecting Include Cursor.
Screen (Input)  
Entire Window (Input)  
Window Client Area (Input)  
Last Active Window (Input)  
Region (Input)  
BMP File (Input)  
Clipboard (Input)  
Include Cursor (Input)  



Screen (Input) 
Select the Screen option from the SnagIt/32 Input menu to capture the entire Windows desktop 
(everything visible on the screen).
To capture an image of the Windows desktop:

1. Set the input parameter to Screen.
2. Press your hotkey combination.



Entire Window (Input) 
Select the Entire Window option from the SnagIt/32 Input menu to capture an entire user selected 
window. The captured image will include the border, title bar, menu bar, scroll bars and caption line.

To capture an image of a window:
1. Set the input parameter to Entire Window.
2. Press your hotkey combination.
3. The cursor will change to a finger pointer. Select the desired window by positioning the finger 

pointer inside the window and clicking the left mouse button.

WINDOW SELECTION TIP:
To be sure that SnagIt/32 captures the entire window, position the finger pointer in the window's title bar 
before you click the left mouse button to select the window.
Other items within a window, such as the OK and Cancel buttons, are actually small windows. If you click 
on one of these items with the finger pointer, you will only capture that item instead of the entire window.



Window Client Area (Input) 
Select the Window Client Area option from the SnagIt/32 Input menu to capture the client area of a 
specific window. The client area is the main body of the window inside the window borders. It does not 
include the window borders, title bar, menu bar, scroll bars or caption line.
To capture an image of a window client area:

1. Set the input parameter to Window Client Area.
2. Press your hotkey combination.
3. The cursor will change to a finger pointer. Select the desired window by positioning the finger 

pointer inside the window and clicking the left mouse button.



Last Active Window (Input) 
Select the Last Active Window option from the SnagIt/32 Input menu to capture the last active window 
(the window that has the focus on the Windows desktop when SnagIt/32 is invoked).
To capture an image of the last active window:

1. Set the input parameter to Last Active Window.
2. Press your hotkey combination.



Region (Input) 
Select the Region option from the SnagIt/32 Input menu to capture a user defined rectangular region of 
the screen.
To capture an image of part of the screen:

1. Set the input parameter to Region.
2. Press your hotkey combination.
3. The cursor will change to a hand holding cross hairs. Position the cross hairs in the upper left 

corner of the region you want to capture.
4. Press and hold the left mouse button. Drag the pointer diagonally, to the lower right corner of the 

region. You will see a rectangular outline defining the region SnagIt/32 will capture.
5. When you have outlined the region you want to capture, release the mouse button.

If SnagIt/32's title bar is visible on the Windows desktop when you capture a region, it will display the 
vertical and horizontal dimensions (in pixels) of the region you have outlined.



BMP File (Input) 
Select the BMP File option from the SnagIt/32 Input menu to capture an image stored in a Windows 
bitmap file.
To capture an image of a BMP file:

1. Set the input parameter to BMP File.
2. Press your hotkey combination.
3. Enter the name of the file containing the image you want to capture.
4. Click on the Open button.



Clipboard (Input) 
Select the Clipboard option from the SnagIt/32 Input menu to capture the contents of the Windows 
clipboard.
To capture an image from the Clipboard:

1. Set the input parameter to Clipboard.
2. Press your hotkey combination.



Include Cursor (Input) 
Select the Include Cursor option from the SnagIt/32 Input menu to include your cursor in the image that 
you want to capture. This option only operates if you have selected the Screen option or the Last Active 
Window option from the SnagIt/32 Input menu.
To include the cursor pointer in your image:

1. Set the Input parameter to Include Cursor in combination with either the Screen or Last Active 
options.

2. Press your hotkey combination.



Output options 
The SnagIt/32 Output options allow you designate what SnagIt/32 will do with the captured image. The 
captured image can be sent to the Printer, the Windows Clipboard, saved to a File or attached to a Mail 
note. 
Printer (Output)  
Clipboard (Output)  
File (Output)  
Send Mail (Output)  



Printer (Output) 
Select the Printer option from the SnagIt/32 Output menu to send the captured image to your default 
Windows printer. While SnagIt/32 is printing, a status box will be displayed. To stop the printing process, 
select Cancel at any time.



Clipboard (Output) 
Select the Clipboard option from the SnagIt/32 Output menu to send the captured image to the Windows
clipboard. Once an image is in the clipboard, you can paste it into another Windows application or save it 
as a clipboard file (.CLP).



File (Output) 
Select the File option from the SnagIt/32 Output menu to save the captured image to a file. With this 
option you can save your files in six graphic file formats. 

· Specify the graphic file format type for your saved image. Select BMP or Compressed BMP for a
Windows Bitmap file, PCX for a PC Paintbrush file, TIF for a Tag Image File or JPEG (50%) or 
JPEG (75%) for a JPEG Compressed Graphic file.
Note: The file format you choose can have a dramatic effect on the saved file size. The 
following are examples of one image (256 colors, 510 pixels by 270 pixels) saved in 
various file formats.

Monochrome Color / Grayscale
BMP 18k 137k
BMP(Compressed) 18k 23k
PCX 5k 21k
TIF 18k 137k
JPEG - 75% 18k 22k
JPEG - 50% 15k 16k

· If you would like SnagIt/32 to automatically name and sequentially number your saved images, 
select the Automatic File Naming checkbox. Specify the first five characters of the named series
you would like SnagIt/32 to use when it saves a file automatically (the default is SNAG-). As long 
as this option remains in effect, whenever SnagIt/32 saves a file, it will give the file a name that 
starts with the designated five characters and a sequential number (i.e. SNAG-1, SNAG-2...)

· Select the File Output Drive from the drop down window at the bottom of the dialog box.
· Select the File Output Directory to specify into which directory the files will be placed.
· Click on the OK button.



Send Mail (Output) 
Select the Send Mail option from the SnagIt/32 Output menu to attach the captured image to a mailnote. 
The file type for the attached image is determined from the current File output setting. Once the image is 
attached to the mailnote,    the mailnote will be displayed. You then enter your regular electronic mail 
information and select Send.

Note: The Send Mail output option is only supported if you have a 32-bit MAPI mail client installed
(e.g., Microsoft Exchange).



Format options 
The SnagIt/32 Format options let you choose a color format for the captured image. Your choices are 
Color, Monochrome or Grayscale.
Color 
Monochrome 
Grayscale 

Note: The file format you choose can have a dramatic effect on the saved file size. The following 
are examples of one image (256 colors, 510 pixels by 270 pixels) saved in various file and color 
formats.

Monochrome Color / Grayscale
BMP 18k 137k
BMP(Compressed) 18k 23k
PCX 5k 21k
TIF 18k 137k
JPEG - 75% 18k 22k
JPEG - 50% 15k 16k



Color
Select the Color option from the SnagIt/32 Format menu to retain all of the screen color information with 
the captured image.
If you are sending the captured image to the Windows clipboard,a BMP file, or a color printer (using an 
appropriate Windows color printer driver), the image will print in color.
COLOR FORMAT TIP:

Even if you are using SnagIt/32 to print captured images to a standard, black and white printer, you can 
still leave the format option set to Color. The Windows printer driver for your printer will convert the image 
to grayscale-type output. In fact, most printed images will probably look their best if you set the format 
option to Color.

Unless you have a specific need to capture monochrome or grayscale images, we recommend leaving 
the format option set to Color.



Monochrome
Select the Monochrome option from the SnagIt/32 Format menu to convert the captured image to 
monochrome (black and white). 
With monochrome images, the intensity threshold level determines the amount of black and white that will
appear in the output image. When the captured image consists of predominantly one color, or a small 
number of similar colors, the converted image can end up looking too dark or too light.
When you select Monochrome from the format menu, a dialog box will appear, allowing you to customize
the intensity threshold for a particular image.
In general, you should not need to change the intensity threshold. (Click on the OK button to accept the 
default.)
However, if a captured image looks too dark or too light, try adjusting the intensity threshold for the image,
according to the following guidelines:

· If the image is too dark, lower the intensity threshold percentage.
· If the image is too light, raise the intensity threshold percentage.

To revert to the default intensity threshold setting, click on the Default button.



Grayscale
Select the Grayscale option from the SnagIt/32 Format menu to convert the captured image to a 
grayscale (black and white patterns that simulate gray).
This option is useful if your printer cannot print color images in black and white. (These printers are 
generally older models, and are relatively rare.) You should note, however, that converting images to 
grayscale is a pixel-by-pixel process, and can be slow.



Other options
The SnagIt/32 Options menu lists additional SnagIt/32 features and options. These include Alert, 
Clipboard Chain, Color Boost and Scale. You also have the option of saving these settings by selecting 
Save Setup. The Options menu also includes an Advanced Options section which allows you to redefine 
your Hotkey(s) and to select a printer other than the Windows default printer.
Alert 
Clipboard Chain 
Color Boost 
Scale 
Save Setup 
Advanced Options 



Alert
Select the Alert option from the SnagIt/32 Options menu to have SnagIt/32 signal you with one or more 
beeps when it has finished input or output processing.
When you select the Alert option, the Completion Alert dialog box will be displayed.
In the dialog box:

1. Enter the "Input # Beeps" (the number of times SnagIt/32 should beep when it has completed 
input processing).

2. Enter the "Output # Beeps" (the number of times SnagIt/32 should beep when it has completed 
output processing).

3. Click on the OK button.



Clipboard Chain
Select the Clipboard Chain option from the SnagIt/32 Options menu to have SnagIt/32 capture the 
contents of the Windows clipboard each time you send something new to the clipboard.
The Clipboard Chain option on the Options menu is a toggle, which is either on or off. To select this 
option:

1. Select the Input option Clipboard,
2. Select any other Output option other than Clipboard, and
3. Select the Clipboard Chain option on the Options menu.

You can use the Clipboard Chain option to capture screens from a full-screen DOS box. When you are 
working in a full-screen DOS session, pressing the Print Screen key* causes Windows to copy the screen
to the clipboard. If you have selected the Clipboard Chain option, SnagIt/32 automatically copies the 
DOS screen image to the specified output device (printer, BMP file or TIFF file).

*Note - If you will be capturing full screen DOS windows on Windows NT, do not select the Print 
Screen key as the SnagIt/32 activation hotkey. This will interfere with the normal Print Screen key 
function in DOS.



Color Boost
Select the Color Boost option from the SnagIt/32 Options menu to adjust the color palette of a captured 
image. This option gives you custom control of the captured images RGB (Red/Green/Blue) values. You 
can use it to:

· Lighten or darken the captured image by altering its color palette;
· Invert the colors of the captured image; or
· Separate an image into its RGB components.

You can use Color Boost to adjust the color intensities for the red, green and blue portions of each pixel. 
On the Color Boost dialog box, you can control the pixel color intensity in two ways:

· Control color saturation by increasing or decreasing the intensity level of individual colors by a 
percentage of the original value. You do this by adjusting the values of the three slider bars. The 
value for each bar (color) ranges from -100% to 1000%. The default value is 100%, which means 
that SnagIt/32 does not change the color value of the original image.

· Control hue by adding or subtracting intensity levels for each color range. You do this by entering 
an offset amount, ranging from -255 to 255, in the Red, Green and Blue Color Enhance boxes. 
The default value is 0, which means that SnagIt/32 does not change the color range of the 
original image.

Once you have modified the RGB values, you must check the Use Color Boost box if you want 
SnagIt/32 to use these values when outputting the captured image.
To restore the default color values, click on the Default button.
Clicking on the Inverse button will set the RGB slider bar and Color Enhance values to values that invert 
the captured images.
To output inverse images, click on the Inverse button and check the Use Color Boost box. SnagIt/32 will 
output captured images with inverted light and dark values. 

INVERSE IMAGE TIP:
The Inverse option is particularly handy when you're trying to capture Windows DOS box screens. Often, 
these screens appear as light or white letters on a dark background. When you select Inverse, SnagIt/32 
will output the image as dark letters on a light background.

Click on the OK button to activate the specified Color Boost values for the current SnagIt/32 session.



Scale
Select the Scale option from the SnagIt/32 Options menu to apply a real scaling factor to a captured 
image before SnagIt/32 outputs the image.
When you select the Scale option, a dialog box will be displayed.
In the Scale dialog box, you can:

· Select User-set Scale, and enter the desired scale value either by typing in the value, or by 
using the arrow controls to raise or lower the scale value. The default, is 1.00.
- The scaling factor is the number by which the size of the captured image will be multiplied, to 

produce the output image size.
- A scaling factor of .50 will produce an image 50% smaller in dpi length and width than the 

original. This factor would be appropriate for full screen captures being sent as mailnote 
attachments. The resulting image size would be 25% of a similar full scale capture.

- A scaling factor of 1.00 means the output image will be the same size as the captured image, 
in dots per inch (dpi). A factor of 1.00 will usually be appropriate for captures to the Windows 
clipboard and to BMP, PCX, TIFF or JPEG files.

- A scaling factor of 3.50 means the output image will be three-and-a-half times as large as the 
captured image, in dpi. A factor of 3.50 is a good place to start with a 300 dpi laser printer, like
an HP LaserJet II or III. 

- A factor of 7.00 is a good place to start with a 600 dpi laser printer.

SCALE OPTION TIP:
Integer values (whole numbers) scale faster than scale values with non-zero decimal places. Setting the 
scale value to a whole number will give you the best performance.

· Select Auto Scale, which will automatically scale the image to produce the largest image that will
fit on the page when you output the captured image to a printer. When you choose Auto Scale, 
SnagIt/32 sets the scaling for any other output option other than Printer (Clipboard, File and Mail) 
to 1.

· Select Proportional Scale to reproduce the image on your screen to scale. This option will use 
the screen size, in pixels, to scale the image you are capturing.

· Select the Correct for aspect ratio checkbox when you want SnagIt/32 to preserve the aspect 
ratio of the screen image in the captured image it sends to the printer. This option only applies to 
printer output. Correct for aspect ratio is selected by default, and you should leave it selected in
most cases.

Unless you have a special need, you should leave the Correct for aspect ratio checkbox selected. 
When it is not selected, SnagIt/32 will do direct one-to-one mapping of source pixels to destination pixels. 
On some printers, the resulting printed image will not have the same proportions as the image displayed 
on the screen. For example, an Epson FX-80 printer prints 120 dots per inch horizontally and 72 dpi 
vertically. With Correct for aspect ratio enabled, SnagIt/32 will map two printer dots horizontally for each
screen pixel, resulting in a printed image that looks much more like the original on the screen.



Save Setup
Select the Save Setup option from the SnagIt/32 Options menu to save SnagIt/32's current configuration
options for future SnagIt/32 sessions.
Selecting Save Setup will save the current values for the following settings to the Windows Registry:

· Input option (Screen, Entire Window, etc.)
· Output option (Printer, Clipboard, File, Mail, etc.)
· Format option (Color, Monochrome, or    Grayscale), including Intensity Threshold for White, if 

applicable
· Alert settings
· Clipboard chain toggle
· Color boost settings
· Scale settings
· Hotkey settings
· Selected printer

You can also save your setup by selecting the Save Setup option on the SnagIt/32 control menu. To 
display the control menu, press ALT+SPACEBAR when SnagIt/32 is maximized, or click on the SnagIt/32 
icon when SnagIt/32 is minimized.



Advanced Options
Advanced Options, located in the SnagIt/32 Options menu, allows you to specify hotkey combinations 
other than the SnagIt/32 default setup, or to choose a printer other than the Windows default printer. 
Change Hotkeys 
Select Printer 



Change Hotkeys

Caution: While SnagIt/32 allows users the flexibility to designate their own HotKey(s), you should take 
care to use keys and or key combinations that are not used in normal typing or by your software 
applications.

Select Change Hotkeys from the Advanced Options submenu.
In the Select activation key box, you can define the keys you will press when you want to capture an 
image. Check the combination of boxes for CTRL, SHIFT, ALT and any keyboard character you want to 
use. You can use any alphabetic character (A-Z), or a function key (F1 - F12) or the Print Screen key*. 
Enter a character by typing it in the box, or use the spin box arrow controls to select it from a list.
Similarly, in the Select hide/unhide key box, you can define the keys you will press to hide or display 
SnagIt/32 on your desktop. Check the combination of boxes for CTRL, SHIFT, ALT and any keyboard 
character you want to use. You can use any alphabetic character (A-Z), or a function key (F1 - F12) or the
Print Screen key*. Enter a character by typing it in the box, or use the spin box arrow controls to select it 
from a list.

*Note - If you select the Print Screen key as the SnagIt/32 activation hotkey on Windows 95, the 
CTRL and SHIFT keys are not supported. Also, if you need to capture full screen DOS windows 
on Windows NT, do not select the Print Screen key as the SnagIt/32 activation hotkey. This will 
interfere with the normal Print Screen key function in DOS.

To restore the SnagIt/32 default hotkey combinations, (CTRL+SHIFT+P to activate and CTRL+SHIFT+X 
to hide/display), click on the Default button.
Example:
If you want to use the key combination CTRL+ALT+C to capture an image, you would check the CTRL 
and ALT boxes under Select activation key, and enter the letter C. Then, to capture a screen, you would 
hold down the CTRL and ALT keys while you press C.



Select Printer
When you select the Printer output option, SnagIt/32 sends screen capture images to the Windows 
default printer. To send your SnagIt/32 screen captures to a printer other than the Windows default, 
choose Select Printer from the Advanced Options submenu.
In the Set the Default Printer for SnagIt/32 box, select the printer you want to use. The Setup button 
displays the Windows printer setup dialog box for the printer you have selected. 
To restore the SnagIt/32 default condition and send your screen captures to the Windows default printer, 
check the Use the Windows Default Printer box.



Command line arguments
SnagIt/32 accepts the following command line arguments:
/hide or /h Hides the SnagIt/32 window at startup.
/nokey or /n Disables keyboard input to SnagIt/32 (For use with DDE applications.)
/icon or /i Starts SnagIt/32 as a minimized icon, instead of in a window.



Using SnagIt/32 to Capture DOS Boxes

This chapter describes how you can use SnagIt/32 to capture images from both full-screen and windowed
DOS boxes.
Capturing full-screen DOS boxes 
Capturing windowed DOS boxes 
Using the inverse option with DOS box captures 



Capturing full-screen DOS boxes
Since SnagIt/32 is a Microsoft Windows program, it cannot capture DOS screens directly. However, 
Microsoft Windows will copy a DOS box screen image to the Windows clipboard when you press the Print
Screen key. SnagIt/32 uses this feature to capture the contents of full-screen DOS boxes.
To capture full-screen DOS boxes with SnagIt/32:

· Set the Input menu option to Clipboard.
· Set the Output menu option to Printer, File or Send Mail.
· You can also select the Clipboard Chain option from the Options menu. If you choose this 

option, SnagIt/32 will capture the image in the Windows clipboard each time the clipboard 
receives something new, and send the captured image to the specified output device.

· DO NOT have the Print Screen key selected as the SnagIt/32 activation hotkey (This will cause a 
conflict with the normal DOS function of the Print Screen key).

When you have SnagIt/32 set up correctly, follow these steps to capture full-screen DOS boxes:
1. Run your DOS application from Windows, in a full-screen DOS box.
2. When the image you want to capture is on the screen, press the Print Screen key.
3. At this point, if you selected the Clipboard Chain option, SnagIt/32 will minimize your DOS 

session to an icon. SnagIt/32 will then display status and or input windows relevant to the output 
you have selected. When SnagIt/32 has finished processing, double-click on the DOS icon to re-
enter your DOS session.

If you did not select the Clipboard Chain option, and you want SnagIt/32 to capture the image you sent 
to the Windows clipboard when you pressed Print Screen, you must capture the image manually. Follow 
these steps:

· Exit or minimize your DOS session.
· Press your hotkey combination to capture the contents of the Windows clipboard and send the 

image to the specified output device. Again, input must be Clipboard; output can be anything but 
Clipboard.

You can use this method to capture any number of full-screen DOS boxes, but you will need to re-enter 
your DOS session after every screen capture.

NOTE:
If your DOS application uses a proprietary video mode, you may not be able to use SnagIt/32 to capture 
DOS screens from that application. (When a DOS application uses a proprietary video mode, Windows 
cannot capture the image to the clipboard, so Windows programs like SnagIt/32 cannot access the 
image.)



Capturing windowed DOS boxes
You can use SnagIt/32 to capture screens of DOS applications running in Windows DOS boxes. To 
capture the contents of a windowed DOS box with SnagIt/32:

1. The DOS window must be on top of the Windows desktop, but must not have the focus.
2. Set the Input menu option to Screen, Entire Window,Window Client Area or 

Region,depending on your requirements.
· Screen will capture everything on the Windows desktop, including the windowed DOS box.
· Entire Window will capture the DOS window, including the border, title bar, etc.
· Window Client Area will capture only the contents of the DOS window, without the border, 

title bar and other Windows elements. This option will give you much the same effect as 
capturing a full-screen DOS box.

· Region will allow you to specify a portion of the screen to capture, and may include the 
windowed DOS box.

The other Input Options; Last Active Window,BMP File and Clipboard are not applicable.
3. Select any Output menu option.
4. Do not select the Clipboard Chain option; it will not work when capturing windowed DOS boxes 

because input is not coming from the Windows clipboard.
When you have SnagIt/32 set up correctly, use the following steps to capture windowed DOS boxes:

1. Run your DOS application in a Windows DOS box.
2. Position the image you wish to capture in the DOS window.
3. Move the focus off the DOS window, but leave the DOS window visible on the desktop. To do this:

· Click once on any icon on the desktop. This will shift the focus from the DOS window to the 
icon, but will also open the control menu associated with the icon.

· Click once on a "blank" portion of the Windows desktop to close the icon's control menu.
4. Press your hotkey combination to capture the image.



Using the inverse option with DOS box captures
Because DOS screens and DOS applications often appear as white or light-colored letters on a dark 
background, DOS box screen captures may look better if you use SnagIt/32's Inverse option.
To activate SnagIt/32's inverse option, follow these steps:

1. From SnagIt/32's Options menu, select the Color Boost option.
2. On the Color Boost dialog box, click on the Inverse button, and select the "Use Color Boost" 

checkbox.
3. Click on the OK button.

Your captured images will now appear as dark characters on a white background.



Adding SnagIt/32 to Other Applications

Using SnagIt/32 as a DDE server 
DDE command reference 
Installing the SnagIt/32 Word for Windows macro 
Activating SnagIt/32 from Word for Windows 



Using SnagIt/32 as a DDE server
SnagIt/32 is a fully functional Windows Dynamic Data Exchange (DDE) server. You can use SnagIt/32's 
DDE support to incorporate SnagIt/32 functionality into custom or commercial Windows programs that 
support DDE. For example, you could write a Microsoft Excel macro to print a portion of the screen using 
SnagIt/32.



DDE command reference
Following is a reference for the DDE commands that a DDE client application can use to communicate 
with SnagIt/32.
For more information about using DDE in Windows programs and macros, refer to the DDE section in the 
Windows Software Developer's Kit reference, Windows Guide to Programming. If you want to incorporate 
SnagIt/32 functionality into a commercial Windows application, you can also refer to the macro language 
documentation for your application.
Please note that the syntax of specific DDE commands (DDE_INITIATE, DDE_EXECUTE, etc.) will vary 
from one application to another, depending on the implementation of DDE commands in the application's 
macro language. The parameters required for accessing SnagIt/32, however, will not vary.
Initiating a DDE session with SnagIt/32 
Setting SnagIt/32 configuration options 
Invoking SnagIt/32  
Invoking Enhanced SnagIt/32 
Determining SnagIt/32's status 



Initiating a DDE session with SnagIt/32
To initiate a DDE session with SnagIt/32, you must send a DDE_INITIATE message with the application 
parameter of "SnagIt" and the topic parameter of "System":

[DDE_INITIATE command] SnagIt System

Note: Because it creates the connection, the DDE_INITIATE command must be the first command issued.
To release system resources when the channel is no longer required, issue a DDE_TERMINATE. 



Setting SnagIt/32 configuration options
You can set SnagIt/32 configuration options    the input, output, format and other options typically set 
through the SnagIt/32 menus    in one of two ways: with the DDE_EXECUTE set command, or with the 
DDE_POKE command.
Setting options with DDE_EXECUTE 
Setting options with DDE_POKE 



Setting options with DDE_EXECUTE
The general syntax of the DDE_EXECUTE set command is:

[DDE_EXECUTE command] set("parameter_value")

With the DDE_EXECUTE set command, the parameter_value may be any one of the following:

Parameter Value Result
add red_nnn, 
blue_nnn,green_nnn

Enable SnagIt/32's Color Boost option (equivalent to selecting the 
"Use Color Boost" checkbox on the Color Boost dialog), and set the 
RGB color hue additive values (the three Color Enhance fields on 
the Color Boost dialog) to red_nnn for red, blue_nnn for blue, and 
green_nnn for green.
Separate the RGB additive values by commas, with no spaces 
before or after the commas. 

aspect off Do not maintain image aspect ratio when printing.
aspect on Maintain image aspect ratio when printing.
autoname Set the Filename parameter to CCCCC.
boost off Disable SnagIt/32's Color Boost option (equivalent to de-selecting 

the "Use Color Boost" checkbox on the Color Boost dialog).
boost red_nnn, 
blue_nnn,green_nnn

Enable SnagIt/32's Color Boost option (equivalent to selecting the 
"Use Color Boost" checkbox on the Color Boost dialog), and set the 
RGB color saturation multipliers (the three slider bars on the Color 
Boost dialog) to red_nnn for red, blue_nnn for blue, and green_nnn 
for green.
Separate the RGB multiplier values by commas, with no spaces 
before or after the commas. 

chain Toggle the Clipboard Chain parameter.
device [printer_name], 
[driver_name], [port]

Direct output to the specified printer, using specified driver and port.

format color Set the Format parameter to Color.
format gray Set the Format parameter to    Grayscale.
format mono,nn Set the Format parameter to Monochrome, and the Monochrome 

intensity threshold to the value specified as nn.
The "mono,nn" portion of the string cannot contain spaces. If you do 
not specify a numeric value, SnagIt/32 will use the current intensity 
threshold value as the default.

hidekey nnnn Set hide/unhide hotkey combination to nnnn. The high byte specifies
Control keys:

0x01 CTRL key
0x02 ALT key
0x04 SHIFT key
0x08 function key, F1-F12

Low byte specifies the key pressed:
 0x41-0x5 hotkeys ASCII value
 0x01-0x0c function key F1-F12,

                                                  if 0x08 bit is set in high byte
inalert n Set the Input # Beeps for the Alert parameter to the value specified 

as n.
input client Set the Input parameter to Window Client Area.
input clipboard Set the Input parameter to Clipboard.
input file Set the Input parameter to BMP File.
input last Set the Input parameter to Last Active Window.
input region Set the Input parameter to Region.



input screen Set the Input parameter to Screen.
input window Set the Input parameter to Entire Window.
mailsubject text Set the Mail Output subject to "text".
mailtext text Include "text" in the message body for Mail Output.
mailname name Set the Mail Output recipient name. If the "mailaddress" parameter is

not set, "name" must be a valid Mail phonebook name. If the 
"mailaddress" parameter is set, "name" may contain the display 
name for the mail recipient.

mailaddress address Set a provider specific Mail Output recipient address. This parameter
is optional if "mailname" specifies a valid Mail phonebook name.

options nnnn Set options. The nnnn byte specifies the following    Options:
            0x01 captures mouse cursor
            0x02 turns on automatic file naming 

outalert n Set the Output # Beeps for the Alert parameter to the value specified
as n.

output bmp Set the Output parameter to BMP File.
output cbmp Set the Output parameter to Compressed BMP File.
output clipboard Set the Output parameter to Clipboard.
output file Set the Output parameter to BMP File.
output jpeg Set the Output parameter to JPEG File with 75% image quality.
output mail Set the Output parameter to Send Mail. The current file output 

configuration is used for the type of attached mail file.
If the mail recipient name or address is specified by the 
"mailname" and/or "mailaddress" parameter, the user will not 
be prompted for information before the mail message is sent.

output pcx Set the Output parameter to PCX File.
output printer Set the Output parameter to Printer.
output tiff Set the Output parameter to TIFF Mono File.
profile active Use the active SnagIt/32 configuration profile for this DDE session.    

This is the same configuration profile used by the SnagIt/32 menus.   
This is the profile used for a DDE session if the "profile" parameter is
not used.

profile default Use the SnagIt/32 default configuration profile for this DDE session.  
Changes only effect this DDE session and do not effect the active 
SnagIt/32 configuration. The "snagkey", "hidekey", and "chain" 
parameters are disabled for this profile setting.

profile saved Use the SnagIt/32 configuration profile saved in the system registry 
for this DDE session. Configuration    changes only effect this DDE 
session and do not affect the active SnagIt/32 configuration. The 
snagkey", "hidekey", and "chain" parameters are disabled for this 
profile setting.

scale auto Set scale option to auto scale.
scale n Set the Scale value to n.
scale pro Set scale option to proportional scale.
snagdir Set the File Output Directory parameter to a valid path.
snagkey nnnn Set activation hotkey combination to nnnn. The high byte specifies 

Control keys:
0x01 CTRL key
0x02 ALT key
0x04 SHIFT key
0x08 function key, F1-F12
0x10 PRINT SCREEN key

Low byte specifies the key pressed:



0x00 if 0x10 bit is set in high byte
0x41-0x5 specifies hotkeys ASCII value
0x01-0x0c specifies function key F1-F12, 

if 0x08 bit is set in high byte
window hide Hides the SnagIt/32 window or icon.
window show Displays the SnagIt/32 window or icon.

Examples
Use DDE_EXECUTE to set the input parameter to clipboard:

[DDE_EXECUTE command] set("input clipboard")

Use DDE_EXECUTE to direct SnagIt/32 output to Microsoft Fax:

[DDE_EXECUTE command] set("device Microsoft Fax, MSFAX, LPT1:")

Use DDE_EXECUTE to set the format parameter to Monochrome and the intensity threshold to 85 
percent:

[DDE_EXECUTE command] set("format mono,85")

Use DDE_EXECUTE to enable Color Boost's color saturation multipliers and set the RGB values:

[DDE_EXECUTE command] set("boost 200,250,200")

Use DDE_EXECUTE to use the application default configuration profile to obtain a known configuration 
and not effect the active application configuration:

[DDE_EXECUTE command] set("profile default")

Use DDE_EXECUTE to send SnagIt/32 output as a compressed BMP file mail attachment:

[DDE_EXECUTE command] set("output cbmp")

[DDE_EXECUTE command] set("output mail")

Use DDE_EXECUTE to send SnagIt/32 output as a mail attachment with the specified Subject and Text.   
The user will be prompted for the mail destination.

[DDE_EXECUTE command] set("output mail")

[DDE_EXECUTE command] set("mailsubject Backup failed!")

[DDE_EXECUTE command] set("mailtext        Why is this happening?")

Use DDE_EXECUTE to send SnagIt/32 output as a mail attachment with the specified Subject to the 
specified recipient.    The user will not be prompted for any information.

[DDE_EXECUTE command] set("output mail")

[DDE_EXECUTE command] set("mailsubject Process monitor 1:03AM")

[DDE_EXECUTE command] set("mailname Operations Staff")



Setting options with DDE_POKE
The general syntax of the DDE_POKE command is:

[DDE_POKE command] "parameter", "value"

With the DDE_POKE command, the parameter and value strings may be one of the following 
combinations:

Parameter Values Result
add red_nnn, 

blue_nnn, 
green_nnn

Enable SnagIt/32's Color Boost option (equivalent to selecting the 
"Use Color Boost" checkbox on the Color Boost dialog), and set 
the RGB color hue additive values (the three Color Enhance fields
on the Color Boost dialog) to red_nnn for red, blue_nnn for blue, 
and green_nnn for green.
Separate the RGB additive values by commas, with no spaces 
before or after the commas. 

aspect on Maintain image aspect ratio when printing.
off Do not maintain image aspect ratio when printing.

autoname ccccc Set the Filename parameters.
boost red_nnn, 

blue_nnn, 
green_nnn

Enable SnagIt/32's Color Boost option (equivalent to selecting the 
"Use Color Boost" checkbox on the Color Boost dialog), and set 
the RGB color saturation multipliers (the three slider bars on the 
Color Boost dialog) to red_nnn for red, blue_nnn for blue, and 
green_nnn for green.
Separate the RGB multiplier values by commas, with no spaces 
before or after the commas.

off Disable SnagIt/32's Color Boost option (equivalent to de-selecting 
the "Use Color Boost" checkbox on the Color Boost dialog).

chain Toggle the Clipboard Chain parameter.
format mono,nn Set the Format parameter to Monochrome, and the Monochrome 

intensity threshold to the value specified as nn.
The "mono,nn" portion of the string cannot contain spaces. If you 
do not specify a numeric value, SnagIt/32 will use the current 
intensity threshold value as the default.

color Set the Format parameter to Color.
gray Set the Format parameter to    Grayscale.

hidekey nnnn Set hide/unhide hotkey combination to nnnn. The high byte 
specifies Control keys:

0x01 CTRL key
0x02 ALT key
0x04 SHIFT key
0x08 function key, F1-F12

Low byte specifies the key pressed:
 0x41-0x5 hotkeys ASCII value
 0x01-0x0c function key F1-F12,

                                                  if 0x08 bit is set in high byte
inalert n Set the Input # Beeps for the Alert parameter to the value 

specified as n.
input screen Set the Input parameter to Screen.

window Set the Input parameter to Entire Window.
client Set the Input parameter to Window Client Area.
last Set the Input parameter to Last Active Window.
region Set the Input parameter to Region.
file Set the Input parameter to BMP File.



clipboard Set the Input parameter to Clipboard.
mailsubject text Set the Mail Output subject to "text".
mailtext text Include "text" in the message body for Mail Output.
mailname name Set the Mail Output recipient name.    If the "mailaddress" 

parameter is not set, "name" must be a valid Mail phonebook
name.    If the "mailaddress" parameter is set, "name" may contain
the display name for the mail recipient.

mailaddress address Set a provider specific Mail Output recipient address.    This 
parameter is optional if "mailname" specifies a valid Mail 
phonebook name.

options nnnn Set options. The nnnn byte specifies the following Options:
                                0x01 captures mouse cursor
                                0x02    turns on automatic file naming 

outalert n Set the Output # Beeps for the Alert parameter to the value 
specified as n.

output bmp Set the Output parameter to BMP File.
cbmp Set the Output parameter to compressed BMP File.
clipboard Set the Output parameter to Clipboard.
file Set the Output parameter to BMP File.
jpeg Set the Output parameter to JPEG File with 75% image quality.
mail Set the Output parameter to Send Mail.    The current file output 

configuration is used for the type of attached mail file.
If the mail recipient name or address is specified by the 
"mailname" and/or "mailaddress" parameter, the user will not be 
prompted for information before the mail message is sent.

printer Set the Output parameter to Printer.
tiff Set the Output parameter to TIFF Mono File.
pcx Set the Output parameter to PCX File.

profile active Use the active SnagIt/32 configuration profile for this DDE 
session.    This is the same configuration profile used by the 
SnagIt/32 menus.    This is the profile used for a DDE session if 
the "profile" parameter is not used.

saved Use the SnagIt/32 configuration profile saved in the system 
registry for this DDE session.    Configuration    changes only effect
this DDE session and do not effect the active SnagIt/32 
configuration. The "snagkey", "hidekey", and "chain" parameters 
are disabled for this profile setting.

default Use the SnagIt/32 default configuration profile for this DDE 
session.    Changes only effect this DDE session and do not effect 
the active SnagIt/32 configuration. The "snagkey", "hidekey", and 
"chain" parameters are disabled for this profile setting.

scale n Set the Scale value to the value specified as n.
auto Set scaling to auto scale.

snagdir ddddd Set File Output Directory parameter.
snagkey nnnn Set activation hotkey combination to nnnn. The high byte specifies

Control keys:
0x01 CTRL key
0x02 ALT key
0x04 SHIFT key
0x08 function key, F1-F12
0x10 PRINT SCREEN key

Low byte specifies the key pressed:
0x00 if 0x10 bit is set in high byte
0x41-0x5 hotkeys ASCII value



0x01-0x0c function key F1-F12, 
if 0x08 bit is set in high byte

window show Displays the SnagIt/32 window or icon.
hide Hides the SnagIt/32 window or icon.

Examples
Use DDE_POKE to set the input parameter to clipboard:

[DDE_POKE command] "input", "clipboard"

Use DDE_POKE to set the format parameter to Monochrome and the intensity threshold to 85 percent:

[DDE_POKE command] "format", "mono,85"

Use DDE_POKE to enable Color Boost's color saturation multipliers and set the RGB values:

[DDE_POKE command] "boost", "200 250 200"

Use DDE_POKE to use the saved application configuration profile to obtain user tailored settings and not 
effect the active application configuration:

[DDE_POKE command] set("profile saved")

Use DDE_POKE to send SnagIt/32 output as a JPEG file mail attachment:

[DDE_POKE command] set("output jpeg")

[DDE_POKE command] set("output mail")

Use DDE_POKE to send SnagIt/32 output as a mail attachment with the specified Subject and to a 
provider specific mail address.

[DDE_POKE command] set("output mail")

[DDE_POKE command] set("mailsubject Win95 crashed again")

[DDE_POKE command] set("mailaddress SMTP:billg@microsoft.com")

MICROSOFT WINDOWS SDK PROGRAMMERS TIP:
Note that the data format for DDE_POKE commands must be the valid clipboard format CF_TEXT.



Invoking SnagIt/32 
SnagIt/32's capture process is invoked with the DDE_EXECUTE snag command.
The general syntax of the DDE_EXECUTE snag command is:

[DDE_EXECUTE command] snag([input_parameter])

With the DDE_EXECUTE snag command, you can specify an input parameter value. If you do, this input 
parameter will override SnagIt/32's current input setting. Note that some of the input parameters available
at capture time are not available as pre-set options, either via the SnagIt/32 menus or with DDE 
commands.
The input_parameter used with the DDE_EXECUTE snag command may be any one of the following:

Input Parameter Result
empty or null Capture image using current input and other parameters 

(equivalent to pressing your hotkey sequence).
clipboard Capture image in the Clipboard.
screen Capture the image on the Screen.
[file_name] Capture the image in the specified BMP File.
last Capture the Last Active Window.
x_nnn y_nnn Capture the Entire Window containing the point at the x and y 

coordinates, specified as x_nnn and y_nnn (equivalent to 
using the finger pointer to specify the window to capture).
(Note that the x,y screen coordinate 0,0 is the point in the 
upper left corner of the screen, and that the x coordinate 
represents the point on the horizontal axis, and the y 
coordinate represents the point on the vertical axis. The value 
of the x,y screen coordinate in the bottom right corner of the 
screen depends on your screen resolution.)

client x_nnn y_nnn Capture the Window Client Area containing the point at the x 
and y coordinates, specified as x_nnn and y_nnn. 

handle [window_ handle] Capture the Entire Window of the window specified by 
window_handle.(Windows establishes the window_handle. It is
ascertained by a source other than SnagIt/32.)

client handle [window_ handle] Capture the Window Client Area of the window specified by 
window_handle.

x1_nnn y1_nnn x2_nnn y2_nnn Capture the rectangular area bounded by the first set of xy 
coordinates (specified as x1_nnn and y1_nnn) and the second 
set of xy coordinates (specified as x2_nnn and y2_nnn). The 
result is the same as capturing a Region with SnagIt/32.

exit Terminate SnagIt/32.

Examples
Capture an image using the current SnagIt/32 input, output, format and other parameters:

[DDE_EXECUTE command] snag()

Capture the bitmapped image stored in the file CAR.BMP, using the current SnagIt/32 output, format and 
other parameters:

[DDE_EXECUTE command] snag("c:\windows\car.bmp")

Capture the rectangular screen area bounded by the xy coordinates at 0,0 and 350,500:



[DDE_EXECUTE command] snag("0 0 350 500")

Capture the window client area for the window with handle "0x43B":

[DDE_EXECUTE command] snag("client handle 0x43B")

NOTE: You can use numbers in either decimal or hexadecimal format in SnagIt/32 DDE commands. Hex 
values must begin with "0x".



Invoking Enhanced SnagIt/32
SnagIt/32s capture process can be invoked and configured in a single command string.    The settings 
specified in an Esnag command string only apply to one capture. 
The general syntax of the DDE_EXECUTE Esnag command is:

[DDE_EXECUTE command] Esnag([input_parameter], [output_parameter], [format_parameter], 
[scale_parameter], [options_parameter])

With the DDE_EXECUTE Esnag command, you can specify input, output, format, scale and option 
parameters for a single capture. All parameters will return to saved/default settings after the capture is 
performed. 
 

Input Parameter Result
DEF Captures the default input .
CLP Captures the Clipboard.
SCR Captures the Screen.
LST Captures the Last Active Window. 
BMP Captures a BMP file, where [filename] is an existing Windows 

BMP file.
WIN x y Captures the entire window containing the      point x y.
CLI x y  Captures the Window Client Area containing the                point 

x y.
WHD h Captures the Entire Window specified by the window handle 

h.
CHD h Captures the Window Client Area specified by the window 

handle h. 
REG xl yl x2 y2 Captures the rectangular area specified by the points x1 y1 

and x2 y2. 

Output Parameter Result
DEF Output to default.
CBMP [file_name] Output to a compressed Windows BMP File. (Providing 

[file_name] is optional.)
JPG [file_name] Output to JPEG File with 75% image quality. (Providing 

[file_name] is optional.)
MAIL Send output as a mail attachment.    The current file output 

configuration is used for the type of attached mail file.
PRN Output to the Printer
CLP Output to the Clipboard.
BMP [file_name] Output to a Windows BMP file. (Providing [file_name] is 

optional.)
PCX [file_name] Output to a PCX file. (Providing [file_name] is optional.)
TIF Output to a TIF file. (Providing [file_name] is optional.) 

Format Parameter Result
DEF Implements default format.
COL Implements Color format .
MON t Implements Monochrome format with Intensity Threshold for 

White specified by value t.



GRY Implements    Grayscale format. 

Scale Parameter Result
DEF Implement s default scale method.
VAL s Scales up the image by the factor specified by s.
AUT Implements Auto Scale. 
PRO Implements Proportional Scale.

Option Parameter Result
DEF Implements default options.
b Implements options specified by b where b is a bitmask for the

following options:
0 x 01 Include Mouse Cursor
0 x 02 Automatic File Naming
0 x 04 Correct for Aspect Ratio
0 x 08 Invert Image Colors

Examples
Capture using default settings for all Esnag parameters. The Esnag command, executed without 
specified parameters, will behave like the snag command executed without specified parameters. 

[DDE_EXECUTE command] Esnag (DEF, DEF, DEF, DEF, DEF)

Capture the Last Active Window. Here , only the input parameter is specified; all other parameters use 
default settings. Therefore, the Esnag command, executed with an input parameter, behaves like the 
snag command executed with a specified parameter. (Remember, the snag command can only use input
parameters.)

[DDE_EXECUTE command] Esnag (LST, DEF, DEF, DEF, DEF)

Capture the Screen to a TIF file named SCREEN1.TIF. Now, both the input and output parameters are 
specified in the Esnag command line; all other parameters use default settings. 

[DDE_EXECUTE command] Esnag (SCR, TIF SCREEN1.TIF, DEF, DEF, DEF)

Capture the Screen to a TIF file name SCREEN1.TIF, this time specifying the format and scale 
parameters. In the Esnag command line, the format parameter is set to color and the scale parameter is 
set to Auto Scale, while the parameter for options remains set at the default.

[DDE_EXECUTE] Esnag (SCR, TIF SCREEN1.TIF, COL, AUT, DEF)

Capture the screen to a TIF file named SCREEN1.TIF , set the format to Color, set scale to Auto Scale, 
and enable all four options -- Include Cursor, Automatic File Naming, Correct for Aspect Ratio and Invert 
Image Colors. 

[DDE_EXECUTE] Esnag (SCR, TIF SCREEN1.TIF, COL, AUT, 15) 

Note: The Auto File Naming option is overridden by the output setting when it specifies a filename.

Capture the Entire Screen to a TIF file named SCRSHOT1.TIF , set the format to Color , set a scale factor
of 1, and invert the image colors:

[DDE_EXECUTE command] Esnag (SCR, TIF SCRSHOT1.TIF, COL, VAL 1, 9) 

Capture the entire screen to a JPEG file, set the format to Color, set the scale factor to 1, and include the 
mouse cursor: 

[DDE_EXECUTE command] Esnag (SCR, JPG, COL, VAL 1, 0x01)



Capture the entire screen and send it as a compressed BMP file mail attachment, set the format to Color, 
set the scale factor to 1, and include the mouse cursor:

[DDE_EXECUTE command] Set("output cbmp")

[DDE_EXECUTE command] Esnag (SCR, MAIL, COL, VAL 1, 1)

Capture the default input to a BMP file , set the format to Monochrome with an Intensity Threshold of 40 
and enable the Include Cursor and Automatic File Naming options:

[DDE_EXECUTE command] Esnag (DEF, BMP, MON 40, DEF, 3) 

Note: The maximum length of any DDE command is 80 characters.



Determining SnagIt/32's status
You can query SnagIt/32 about its availability to process another command with the DDE_REQUEST 
status command. The general syntax of the DDE_REQUEST status command is:

[DDE_REQUEST command] status

SnagIt/32 will return either "Ready" or "Busy":
· Ready means SnagIt/32 is available to process another command.
· Busy means SnagIt/32 is currently processing a command.

The ability to query SnagIt/32's status is particularly useful if more than one application is accessing 
SnagIt/32.



Installing the SnagIt/32 Word for Windows macro
The Microsoft Word for Windows macro included on the SnagIt/32 diskette will give you access to 
SnagIt/32 from a MSWord menu. You can use this option to capture screens from other Windows 
applications, and insert those screen captures into your MSWord document.
This macro also illustrates how you can access SnagIt/32 from a commercial application using DDE calls 
in a macro.
Word for Windows 2.0 
Word for Windows 95 and Word for Windows 6.0 



Word for Windows 2.0
Follow these steps to install the SnagIt/32 macro in Word for Windows 2.0:

1. Start SnagIt/32, and then start MSWord.
2. Insert the SnagIt/32 distribution diskette in the floppy drive. 
3. Choose File, Open from the MSWord menu. In the File Name field, type:

a:\snagww.doc
(If necessary, substitute the appropriate diskette drive letter for your system.)
This will open the file SNAGWW.DOC in Word.

4. Select the entire document by choosing Edit, Select All from the menu. Then choose Edit, Copy
from the menu to copy the document to the clipboard.

5. Choose Tools, Macro from the menu.
6. In the Macro dialog box, type "ScreenCapture" in the Macro Name field (with no spaces between

the words), and "Activates SnagIt/32" in the Description field.
7. Press the Edit button to open the macro.
8. Choose Edit, Paste from the menu to paste in the body of the SnagIt/32 macro.
9. To assign the SnagIt/32 macro to a MSWord menu item, choose Tools, Options from the menu. 

This will bring up the Options dialog box.
In the Options dialog box, do the following:
· Choose the Menus option from the Category list.
· In the Menu field, select "&Insert" from the list.
· In the Macros field, select "ScreenCapture" from the list.
· Verify that the text in the Menu Text field reads "&Screen Capture". 
· Press the Add button, and then the Close button.

10. Choose File, Close from the menus. Word will prompt you to confirm that you want to keep your 
changes. Click on the Yes button.

11. Choose File, Save All from the menus. Word will prompt you to confirm that you want to save the
global glossary and command changes. Click on the Yes button.



Word for Windows 95 and Word for Windows 6.0
Follow these steps to install the SnagIt/32 macro in Word for Windows (MSWord) 6.0:

1. Start SnagIt/32, and then start MSWord.
2. Insert the SnagIt/32 distribution diskette in a floppy drive. 
3. Choose File, Open from the MSWord menu. In the File Name field, type:

a:\snagww.doc
(Where a:\ is the appropriate diskette drive letter for your system.)
This will open the file SNAGWW.DOC in Word.

4. Select the entire document by choosing Edit, Select All from the menu. Then choose Edit, Copy
from the menu to copy the document to the clipboard.

5. Choose Tools, Macro from the menu.
6. In the Macro dialog box, type "ScreenCapture" in the Macro Name field (with no spaces between

the words), and "Activates SnagIt/32" in the Description field.
7. Press the Create button to open the macro.
8. Choose Edit, Paste from the menu to paste in the body of the SnagIt/32 macro.
9. To assign the SnagIt/32 macro to a MSWord menu item, choose Tools, Customize from the 

menu. This will bring up the Customize dialog box.
In the Customize dialog box, do the following:
· Click on the Menus folder at the top of the dialog box.
· Choose Macros from the Categories list box.
· Select "ScreenCapture" from the Macros list box.
· Select &Insert from the Change What Menu drop-down list box.
· Select (At Bottom) from the Position on Menu drop-down list box.
· Verify that the text in the Name on Menu field reads "&Screen Capture". 

10. Click on the Add button, and then the Close button.
11. Choose File, Close from the menus. Word will prompt you to confirm that you want to keep your 

changes. Click on the Yes button.
12. Choose File, Save All from the menu. When Word prompts you to confirm that you want to save 

the global glossary and command changes, click on the Yes button.



Activating SnagIt/32 from Word for Windows
Once you have installed the SnagIt/32 MSWord macro, follow these steps to activate SnagIt/32 from 
MSWord:

1. Start SnagIt/32, if you have not already done so. You must start SnagIt/32 before you can use the
MSWord screen capture menu option.

2. Set up the Windows application that has the screen you want to capture. (For testing purposes, 
the Windows desktop will work fine.)

3. Return to MSWord, and position the cursor in your MSWord document at the point where you 
want to insert the screen capture.

4. Select Insert, Screen Capture from the MSWord menus. The resulting dialog box will allow you 
to select the area to be captured.

5. Choose the part of the screen you want SnagIt/32 to capture. 
6. Click on the OK button. SnagIt/32 will minimize MSWord, allow you to specify which window or region you

want to capture (unless you specified the entire screen, in which case you won't need to select a window 
or region), and then capture the specified area. When SnagIt/32 is done with the screen capture, it will 
maximize MSWord and insert the captured screen at the insertion point.
Once Word has inserted the screen capture into your document, you can move, format, or delete it, as 
you would any other graphic object in MSWord.



SnagIt/32 Message Reference

This chapter provides a reference for SnagIt/32 messages.
The messages are listed below, alphabetically, in boldface. In the table following each message, the left 
column contains the message number(s), and the right column contains the explanation and actions 
associated with the message number(s).
Note that each message may have more than one number associated with it. Be sure to note the 
message number when contacting SnagIt/32 Technical Support for assistance.
 No default printer 
Output canceled by user 
Output device error 
Output exceeds printer capabilities 
Out of memory 
Printer does not support bitmaps 
Windows system error 



 No default printer
#9 SnagIt/32 cannot print the captured image because you 

have not specified a Windows default printer. Select a 
default printer in the Windows Control Panel, under 
Printers. Refer to your Windows User's Guide for 
additional information.

Output canceled by user
#5 The user clicked on the Cancel button, so SnagIt/32 did 

not output the image.

Output device error
#1, #4, #8 SnagIt/32 cannot print the captured image. Check your 

printer to be sure it is on-line and operational.
#13, #14 SnagIt/32 cannot write the specified output file. Check 

disk space, file permissions and attributes. If you are 
outputting the captured image to diskette, verify that the 
diskette is not write-protected, and that it is a working 
diskette.

Output exceeds printer capabilities
#11 The Scale factor is set to a value so large that the printer 

cannot fit the image on one page. Decrease the scale 
factor, or select a smaller screen area to print.

Out of memory
#3, #17 The scale factor for the captured image may be too large 

for the amount of available memory. Try reducing the 
scale factor.
Close any unnecessary applications that may be using 
up Windows resources or memory.
Delete the contents of the clipboard.

#6, #12, #15 Windows cannot allocate the memory SnagIt/32 needs to
perform this capture. Exit and restart Windows; reboot 
your computer if necessary. Contact SnagIt/32 Technical 
Support for assistance.

Printer does not support bitmaps
#2 SnagIt/32 cannot print to the Windows default printer 

because that printer does not support graphics. You 
must use a printer that supports graphics with SnagIt/32.

Windows system error
#7, #10, #16, #18, A basic Windows system function has failed. Exit and 



#19 restart Windows; reboot if necessary.
#20, #21 Your video card driver does not support one or more 

Windows system functions. Obtain and install the latest 
driver from your video card manufacturer. Contact 
SnagIt/32 Technical Support if this does not solve the 
problem.

About TechSmith
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TechSmith Corporation
TechSmith Corporation is a technology leader in remote networking solutions.    Since 1987 our mission 
has been to help users maximize the benefits of distributed computing by allowing effective remote 
deployment and use of distributed data and services. TechSmith has designed its family of products to 
meet the unique requirements of organizations needing to support not only their employees, but their 
customers, vendors, and business partners as well. The company has more than 1000 customers, many 
of which are Fortune 100 organizations.
TechSmith is committed to providing reliable, high-quality products that are easy to use. If you have a 
product suggestion or would like more information regarding SnagIt/32, please contact us in one of the 
following ways:

By mail: TechSmith Corporation
Attn.: SnagIt/32 Support
P.O. Box 4758
East Lansing, MI    48826-4758

By phone: (517) 333-2100
By fax: (517) 333-1888
Internet: SnagIt@techsmith.com
CompuServe: 75226,3136



Other TechSmith products
Enterprise Wide Foray PPP Server
Enterprise Wide Foray PPP Server is a cost efficient communications software solution for accessing 
corporate network resources. The Foray PPP Server brings the corporate Internet connection, as well as 
TCP/IP and IPX network services, to the remote user. 
Supporting individuals dialing in with Windows 95, Windows NT, WinSock PPP packages, and PPP 
clients, Foray can provide a centralized remote-access service point.    Network administrators can save 
time and money while providing multiple users with a secure LAN and Internet link. 
An evaluation version is available at http://www.TechSmith.com. 
Send email requests for additional information to Foray@TechSmith.com. 
 

SnagIt (16-bit version)
SnagIt is the screen capture, print and file program for Microsoft Windows 3.x. Users can capture an 
entire screen, a portion of the screen or a single window. SnagIt sends the captured area to the clipboard,
printer or a file for later use in other applications, such as word processors. SnagIt is a fully functional 
Windows DDE    server so it may be incorporated into custom or commercial applications for printing . 
An evaluation version is available at http://www.TechSmith.com. 
Send email requests for additional information to Snagit@TechSmith.com.    
    



Sales information
For more information about TechSmith products, contact TechSmith Sales at (800) 517-3001.



Glossary of Terms
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BMP File 
Command line 
Default settings 
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Hotkey 
Last Active Window 
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Window Client Area 
Windows application 
Windows clipboard 
Windows default printer 



Aspect ratio
The width to height ratio of a screen image.



BMP File
Windows bitmap files have a file extension of .BMP. Windows Paint and other graphics programs 
generate graphic files in this format. Most Windows word processing and desktop publishing programs 
easily import bitmap files into documents.



Command line
The commands you type to run an application. For Windows applications, you enter command line 
arguments in the Run dialog box in File Manager or Program Manager



Default settings
The input, output, format, and other option settings that SnagIt/32 uses unless you specify otherwise.



Dialog box
A window that appears temporarily to request information. Many dialog boxes allow you to select options 
or specify parameters that SnagIt/32 will use to carry out a command.



DOS box
A DOS session running from Windows. A DOS box can occupy the entire screen, or run in a smaller 
window on the desktop.



DPI
Dots Per Inch, typically used to reference printer resolution or clarity. Higher DPI printers are capable of 
producing sharper images.



Entire Window
A SnagIt/32 input option that will capture an entire window, including the border, title bar, menu bar, scroll 
bars and caption line.



File name
A valid file name that conforms to DOS file naming conventions.



Finger pointer
A finger-shaped cursor that you use to select an Entire Window or Window Client Area to capture.



Focus
In Microsoft Windows, the window which has the focus is the one that will receive the next keyboard or 
mouse input. Also, the title bar of the window with the focus will typically be a different color than the title 
bar of other windows.



Hotkey
A key or combination of keys that you press to execute a command or action. The default hotkey 
sequence for invoking SnagIt/32 is CTRL+SHIFT+P.



Last Active Window
A SnagIt/32 input option that captures the last active window (the window that has the focus on the 
Windows desktop when SnagIt/32 is invoked).



PCX File
A graphic file in Windows PC Paintbrush format. Windows PC Paintbrush files have a file extension 
of .PCX..



Pixel
A graphic unit that consists of a single dot on a monitor screen.



Region
A SnagIt/32 input option that captures any rectangular region of the screen.



TIFF File
A graphic file in Tagged Image File Format. TIFF files have a file extension of .TIF. A wide variety of 
application programs on a number of platforms support this format. SnagIt/32 can create only 
monochrome TIFF files.



Window Client Area
A SnagIt/32 input option that captures the client area of a specific window. The client area is the main 
body of the window inside the window borders. It does not include the window borders, title bar, menu bar,
scroll bars or caption line.



Windows application
An application designed to run under Microsoft Windows, which you can only start from Windows, and 
can only run while Windows is running.



Windows clipboard
A location that Windows uses for temporary storage. You can use the clipboard to hold data that you want
to move to a different place in a document, between documents, or between applications. An application's
cut, copy, and paste commands move data into and out of the clipboard. You can use the Clipboard 
Viewer to view the contents of the Clipboard.



Windows default printer
The printer to which Windows applications will send your output if you choose a Print command without 
specifying which printer you want to use. You can select a Windows default printer from the Windows 
Control Panel or Print Manager.
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